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Introduction 
This manual provides an introduction to the general features of the Process of Integration software 

suite. More detailed help on specific aspects of each package can be found in the on-line help system. 

On-line Help 
Help is available from anywhere in the programs by pressing the F1 key. This will open help at the 

contents page. Selecting Help/Contents from the menu or clicking the question mark button on the 

toolbar will also open help at the contents page. In addition, many dialogues have a Help button, which 

will open the help system at the relevant page. The help system is fully searchable and printable. See 

the help topic How to Use Help (within the help system) for full details. 

 

Some help pages have visual demonstrations that use video and, in some cases, audio to describe how 

to use a particular aspect of the software. These are indicated by a video camera icon:-  

 

Most of the packages contain technology overview slideshows, to introduce the fundamentals of the 

technology incorporated within the software. These can be found by clicking on Technology 

Overviews on the help contents page, and are indicated with a slideshow icon: 

 

Some of the packages also include on-line tutorials, which show how to use the supplied example files. 

Select Help/Contents from the main menu, scroll down, and click on Using the Demonstration Files.  

The User Interface 

 
All of the packages have the same basic user interface:- 

 

 

The main window contains a title bar, a menu bar, a tool bar for quick access to the most commonly 

used menu options, and at the bottom of the window, a status bar. The status bar is used to display 

various program status messages while the software is being used. 

The Title Bar 

The title bar shows the path and filename of the currently loaded file. If the filename is followed by 

<R>, it is read-only and can only be saved with a different name. If the filename is followed by <M> it 

has been modified since it was last saved. Double clicking the title bar will maximise the window. 

The Tool Bar 

The tool bar provides quick access to some of the more common menu items. If the Popup Bubble 

Help option is active in the program configuration, holding the mouse pointer over one of the tool bar 
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buttons for a short moment will display a help message indicating its function. The tool bar can be 

customised to include only the buttons used most frequently. 

Configuring the Software 
Many aspects of the programs may be configured, to suit your personal preferences. Start any of the 

programs and select the File/Preferences menu to open the configuration dialogue: - 

 

 

 
 

 

This dialogue is in the form of tabbed property sheets. Some or all of the following property sheets will 

be available, depending on which program you are running. A full description of each of these sheets is 

available in the on-line help. 

General 

This contains general user preferences, mostly relating to the user interface and the appearance of the 

graphical output windows. Place a check mark next to any of the options to select it. 

 

Interface Language 

Some applications have an option to change to interface language. If the language is changed from the 

default (English (UK)), it will try and read the appropriate language dependent files stores in the 

CPI_Suite\<application>\Lex_data folder. If a word or phrase cannot be located in the language file the 

internal English version will be used. The format of the put dialogues are based on the number of 

characters the English words so non-English dialogues may have some layout issues. To maintain 

accelerator key functionality, if the non-English characters string does not have the appropriate 

character then the accelerator appended to the end of the string (e.g. Save file - > Enregistre le 

fichier(v) ). When using a language that is not based on the western alphabet (i.e. Chinse, Arabic etc.) 

then reports printing may become an issue. In these cases, it is advised that the output of the application 

is copied into a more language friendly package (e.g. Microsoft word) for printing 

 

If you are using a non-western language setting you may need to adjust your window language setting 

to use 

WIN 10 : - Install the preferred language (if necessary) 

Start\windows settings\time and language\language\Add a preferred language 
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As the applications are non-unicode, you may need to adjust the setting 

Administrative language settings\administrative\change system locale 

To the appropriate language 

 

Win 7:  - Install the preferred language (if necessary) 

Start\Control panel\region and language\keyboards and languages\Install/uninstall languages 

As the applications are non-unicode, you may need to adjust the setting 

 

Start\Control panel\region and language\administrative\change system locale 

To the appropriate language 

 

PFD 

Contains options relating to the Process Flowsheet Diagram 

Solver 

Some of the packages allow you to choose GAMS as your primary solver, rather than the built in 

solvers. 

Filepath 

This allows you to set the location of various auxiliary files and folders used by the software. These 

include your security key file and the temporary folder, for example. 

Graphics Attributes 

This allows you to customise the appearance of flowsheets, by modifying line colours and styles. 

Design Grid and Flow Diagram 

These property sheets allow you to select which information is displayed on design grids and flow 

diagrams and to sort process streams by several different criteria. 

Toolbar 

Allows you to customise the toolbar by including buttons for the programs features you use most 

frequently. 

 

Click the Save button to save the changes to the configuration. The Restore button will restore the 

settings to the previously saved configuration, and the Defaults button will restore the configuration to 

the program’s internal defaults. 

 

 

Using Units 
The programs have been designed to allow users to specify their own dimensional units. All units are 

selected from the Units Editor, which is accessed from the Edit menu. 
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Each unit has a text description, and a conversion factor to convert the user-defined units into the 

program internal units. For example, to change the Enthalpy units to megawatts, enter “MW” in the 

user units box, and 1000 in the conversion factor box. (1MW = 1000kW). For each unit class there are 

some “Pre-Set” values that you exploit to build your preferred units conversion set. 

 

 
 

Whenever a value has a unit associated with it, the currently selected unit is displayed in square 

brackets – [kJ/kmol]. This convention is used for user input, and for reports. In some instances, where 

correlations are involved, a value must be entered in a specific unit. In this case the unit is displayed in 

round brackets – (dynes/cm). 

 

To export the current unit set to a different project file: 

 

 With the first project file open, select File/Export Unit Set, and select a file name for the unit set 

 Open the second project profile, open the Units Editor (Edit/Units) and select File/Import Unit Set 

 

This procedure may be carried out even for project files in different CPI applications. For example the 

units set in a COLSEQ file can be exported to a project file in STAR. 

 

Using the ‘New Project’ Wizard 
Most of the packages have a New Project wizard to guide you through the basic steps involved in 

setting up a problem. Make sure the Use “New” Wizard is selected in the configuration options, then 

select File/New, or click the New Project toolbar button. 
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For each data item, click Edit to enter the editor. Click Next to advance through the editors, or Back to 

move backwards. The wizard can be closed at any time by clicking the Finish button. 

Previewing Data Files 
It is possible to preview the contents of data files, without having to open the file. Select File/Preview, 

to open the File Preview editor: - 

 

 

 
 

 

The preview box contains a list of data files in the current directory. Clicking on a file in the list will 

display a summary of the contents of the file, and the file description (the description of any file can be 

modified in the Project Description editor – select Project Description from the Edit menu) 

 

To open a file directly from the Preview Editor, either select its name and click Open, or double-click 

the file name. The complete contents of the selected file can be viewed by clicking View. 

 

To change directories click Change Dir… and browse for any file in the required directory. 

Card Index Editors 
 

Most of the packages make use of card index editors, for adding items such as feeds, products or 

utilities. 
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When these editors are first opened, all the entry boxes will appear greyed out. Clicking the Insert 

button will add an item, and the various entry boxes will become available, to enable the properties of 

the new item to be defined. When multiple items are present, clicking the spin-box at the top of the 

window (or pressing the Page Up or Page Down key) will display the next item in sequence. The 

Delete button will delete the currently displayed item, and the Table button will display a report of all 

items, for printing or pasting into a report. 

 

Most of these editors contain an Edit menu, with options for copying and pasting new items.  

 

Most of theses editors have access to the standard windows Calculator (F11) and the standard windows 

Notepad  (Shift+F11)  to permit quick access. 

 

The report viewer can be toggled (Ctrl+F11) between the standard internal report windows and a 

HTML based viewer with enhanced functionality. 

 

 

Report Window 
The text output from each program is displayed in a standard resizeable report window. 
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The contents of the report can be printed by clicking the Print button. The Options menu contains 

functions to save the report as a text file, to copy it the Windows clipboard, to find text in the report 

and to jump to a specified line number. 

 

If the Editable Reports option is checked in the main configuration window, the report can be edited 

before printing, for example to modify the title, or to remove redundant information. 

 

If the “HTML Viewer” is selected in the preferences then  alternative viewer is displayed (currently the 

default windows web browser but is inteded to be replaced with an applicaction based viewer ) which 

(if available)  will have links to various sections with the reports. 

Flowsheet Editor 
Most of the packages make use of the drag-and-drop flowsheet viewer/editor for viewing or creating 

network structures. 

 
 

The flowsheet viewer has its own tool bar with various functions for manipulating the image, or adding 

and editing units and connections. Moving the mouse pointer over a toolbar button will indicate its 

function in the status bar at the bottom of the window. For example, to move a unit:- 

 

 Click the move button   .  The mouse pointer will change shape to indicate move mode. 

 Move units by dragging them to the required location. 

 Exit from move mode by right-clicking the mouse. 

 

The exact functionality of the flowsheet editor and the available buttons will depend on the program 

being used – see the on-line help for details. 
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Graphics Display 
Most of the graphical output is displayed using a standard graphics display window: - 

 
 

 

The graphics window menu bar has the following items:- 

 

 Exit. Closes the graphics window, and returns control to the program 

 Print.  Prints the display (as it currently appears) to the current default windows printer 

 Zoom.  Drag a rectangle to zoom in on any area of the display 

 Full Zooms out to display the complete graph 

 Locate Displays a sub-menu to either display the x-y co-ordinates of the cursor (Coords), or to 

supply additional context-sensitive information if available (Identify) 

 Axes Allows the axes scales to be modified. The display graph titles can also be modified. 

 Marks Toggles marker symbols at each x-y location 

 Attrib. Allows various attributes of the graph, such as line co-ordinates, to be displayed in a 

report. In the case of multiple graphs being plotted on the same axes, it also allows 

individual graphs to be switched on or off.. 

 Annot. Allows annotations and legends to be added to the display. To add an annotation select 

Annot./Add, type the annotation, press return, then click on the display where you would 

like the annotation to appear. To add a legend, select Annot./Legend, and drag a 

rectangle where you would like the legend to appear. 

 Help Opens the help system at the relevant page 

 

Note that while the graphics window is open, none of the menu items or toolbar buttons will be 

available. The graphics window must be closed before control returns to the program. 

 

A message in the status bar indicates whenever the graphics window is open. 

 

 

By default if any data is modified,  when the application  return to the main window the data is 

autmatically saved (~$<filename> ). This can be used to recover project data in the event of a failure. 

By default, these backup file are automatically deleted on normal termination of the application 

 

Physical Property Interfaces 
Several of the packages make extensive use of physical property calculations. Physical property 

calculations can currently be performed in a number of different ways. Each method involves creating a 

Physical Property Source file, which is then loaded into the software in the same way, as described 

below. 
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Using the Built-in Physical Property Engine 

To use the built-in physical property engine it is necessary to create a data file containing all the 

parameters necessary to calculate the properties. These files are called Component Data Files and 

have a .CMP extension. Component Data Files may be created using the Component Editor program 

that is supplied as part of the software suite. Alternatively, most commercial simulators include 

scripting languages which will allow properties to be exported to a file. Contact us for details of the 

Component Data File format if you would like to take advantage of this feature. 

 

When using a Component Data File, all physical properties will then be calculated using the program’s 

own internal routines. Full details on how to create a Component Data File can be found in Component 

Editor’s on-line help.  

Using the Real-time HYSYS/UniSim Interface 

If you are licensed users of Aspen Technology’s HYSYS or Honeywell’s UniSim process simulator, it 

is possible to make use of its physical property engine and component database. The procedure is as 

follows: - 

 

 Start HYSYS/UniSim, and create a new fluid package, consisting of your required components and 

property package. 

 Switch to the simulation environment and create an empty stream, named 

DPI_Temporary_Stream. 

 Save the file (with an HSC/USC extension) and then exit from HYSYS/UniSim. 

 Import the HSC/USC file into the required Process Integration application, as described below. 

 

When this option is chosen all physical properties are calculated by HYSYS/UNISIM. If the Show 

HYSYS/UNISIM User Interface option is checked, on the main configuration window, 

HYSYS/UNISIM will open as a normal window, allowing the current stream properties to be 

examined. If this option is not selected, HYSYS/UNISIM will open and run invisibly in the 

background. 

Using the Real-time Aspen Properties Interface 

If you are licensed users of the Aspen Properties process simulator, provided by Aspen Technology, 

you can use its thermo server for physical properties. 

 

Before using the Aspen thermo server you must configure your computer so that the CPI software can 

find the necessary Aspen files. The procedure is fully documented in the on-line help system. 

 

From any of the packages select Help -> Contents, and then select General -> Physical Property 

Data->Using Aspen. 

Importing the Physical Property Source File 

Once you have created your physical property source file containing the required components and 

property package, it must be imported into the respective package. The method will depend on the 

package you are using. In COLSEQ select Edit/ Physical Properties Data Source, then click the OK 

button. This will open a standard File Open dialogue:- 
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In the File Type drop-down box select the required file type, Component file (CMP), HYSYS file 

(HSC), UniSim file (USC) or Aspen Data file (appdf, aprpdf) and then browse for and open your 

file. This will open the Physical Property Source dialogue:- 

 

 

 
 

 

Click the Open button to open a new file, the Summary button to view summary information for the 

file, or the Clear button to clear the existing file.  

The Equation Editor 
The Equation Editor is a feature that enables users to supply their own correlations, for such things as 

objective functions, reaction kinetics, and refinery models. The editor works by supplying a list of 

interface functions to the program’s internal variables, and allowing the results of calculations to be 

returned back to the program. The basic features of the Equation Editor are the same in each package, 

although the available interface functions vary. The following example shows how the equation editor 

can be used to calculate the cost of a reactor network in the REACTOR program. 
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total_reactor_cost = 0.0 Initialises the total reactor network cost to 0.0. 

 

nr = Get_Num_Reactors( ) This is an example of a function call. A function call 

is followed by round brackets, which may contain a 

list of arguments. This call sets nr to be equal to the 

number of reactors in the network 

 

ir = 0 Sets ir to 0 

 

:Next_Reactor This is an example of a label, as indicated by the 

colon (:) at the start of the line. Labels have no effect, 

but act as locations that can be jumped to with the 

goto command. 

 

ir = ir + 1 Increments ir. which is now equal to 1. 

 

active = Get_Reactor_Active(ir) Another function call. This returns TRUE if reactor 

number ir is active in the network, FALSE otherwise. 

 

if (active = FALSE) goto End_This_Reactor This is an example of a conditional statement. If 

active is equal to false, then the program will jump to 

the label indicated by End_This_Reactor. 

 

rvol = Get_Reactor_Volume(ir) Another example of a function, this time returning the 

volume of reactor number ir. 

 

reactor_cost = 100 + (rvol * 10) Calculates the cost of this reactor. 

 

total_reactor_cost = total_reactor_cost + reactor_cost Adds the cost of this reactor to the running total. 

 

:End_This_Reactor Another label, indicating where the program should 

jump to for inactive reactors. 

 

if (ir < nr) goto Next_Reactor Another example of a condition. This tests to see if 

the current reactor number is less than the total 

number of reactors, and if so loops back to consider 

the next reactor. 
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return total_reactor_cost This returns the total reactor cost network to the 

program. In some of the packages, values can also be 

returned using function calls. 

 

The scripting language used is a subset of the BASIC programming language, although line numbers 

are not required. Full details of the command syntax used, and the available function calls are described 

in each package’s on-line help, but note the following general points:- 

 

 The language is completely case-insensitive. Mixed upper and lower case may be used to increase 

readability. 

 It is not necessary to create the text in the equation editor window. Any text editor can be used to 

edit and save the text, which can then be imported using the Edit/Import from File option on the 

equation editor window. Imported files have the default .EQN extension. 

 A list of the available functions and parameters can be viewed with the Edit/Insert Function and 

Edit/Insert Parameter menu options. Selecting a function or parameter and then clicking the OK 

button will insert the function text in the editor window at the current cursor location. 

 Find, Replace, Goto Line and Undo facilities are also available under the Edit menu. 

 Functions can be used to return values back to the program, as well as to interrogate program 

variables. In general functions which interrogate the program begin with Get_ and functions which 

return values begin with Put_. 

Data Import and Export Procedures 
Some of the packages allow data to be transferred between them using export and import functions. 

 

To export targeting data from ColSEQ to STAR or SPRINT:- 

 

 In the ColSEQ Target menu.   Either Task-based Sequencingor SA/GA Sequencing must have 

been performed 

 Carry out the calculations using the normal procedure, then select Target/Export Stream Data 

File to export an SDF file. 

 To import into STAR, select File/Open, and open the file created in step 2. 

 To import into SPRINT, select File/Import, select Star Files (*.SDF) from the file type 

dropdown, and open the file created in step 2. 

 

To export stream and utility data from STAR to SPRINT 

 

 In STAR, select File/Save, and save an SDF file 

 In SPRINT, select File/Import, select Star Files (*.SDF) from the file type dropdown, and open 

the file created in step 1. 

Using the ColPROF File Converters 
Two file converter programs are available which allow converged simulations in HYSYS or Aspen+ 

(Release 9) to be exported directly to ColPROF (.CPF) files. These converter programs are not 

supplied as part of the standard CPI software package but are available, on request, to licensed users of 

the respective simulator. 

 

Neither converter is a stand-alone program. They require both ColPROF and the respective simulator 

to have been installed. In addition, the Aspen converter requires the Aspen Toolkit to have been 

installed. 

 

Installation 

The converters are supplied as a single file self-extracting installation. 

 

To install from the single file simply run the executable (SETUPEX.EXE). 

 

When selecting the installation directory, it is important to choose the directory into which ColPROF 

was installed. By default this will be C:\Program Files (x86)\CPI Suite 
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Using the Aspen+ Converter 

If the converter has been installed to the default location (i.e. the same directory as the main software 

package) the converter can be launched from ColPROF by selecting Edit/Launch Aspen+ Converter. 

 

 

 
 

 

From the converter File menu, select Convert, and browse for your Aspen backup (.bkp) or summary 

(.sum) file. Once the file has loaded a dialogue will appear, with a list of the columns in the simulation. 

 

Select the required column (RADFRAC columns only), and click OK. A Save dialogue will appear 

asking for a name for the .col file. Select a filename, click OK, and then load the .COL file into 

ColPROF in the usual way. Column exergy and enthalpy profiles can now be plotted using options 

under the Profiles menu. 

 

More detailed help, describing the properties required in the Aspen simulation, are provided in the File 

Converter’s on-line help. In particular please read the section Summary File Property Requirements 

which describes which user-specified physical properties units must be present in the Aspen 

simulation. 

 

Please note that the Aspen+ Toolkit must be loaded for the file converter to work. The converter makes 

use of several files that are only installed as part of the Toolkit. If the file converter gives an error 

message that refers to missing DLL files or missing DAT files, the Toolkit is not correctly installed. 

 

Using the HYSYS Converter 

If the converter has been installed to the default location (i.e. the same directory as the main software 

package) the converter can be launched from ColPROF by selecting Edit/Launch HYSYS Converter. 

 

 

 
 

 

From the converter File menu, select Convert, and browse for your HYSYS simulation file (.hsc). 

HYSYS will automatically be launched and the simulation data extracted. If the simulation consists of 

a single column, a dialogue will appear confirming the column name, otherwise a selection box will 

appear with a list of the columns in the simulation. Select the required column and click OK. 
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Finally, a Save dialogue will appear asking for a name for the .col file. Select a filename, click OK, and 

then load the .COL file into ColPROF in the usual way. Column exergy and enthalpy profiles can now 

be plotted using options under the Profiles menu. 

 

Getting technical support 

How to Get Technical Support 

There can be many and varied reasons for requiring assistance when using a program. It is natural, 

especially for novice users. Please do no think that any question is too trivial other may have the same 

question and it may help us improve the software or help system for others  

What we would expect is that you have taken reasonable to resolve steps to resolve the issue yourself. 

The support question can fall into two board categories  

 Technology related issues - These relate to how case studies are approach, what calculation 

are possible and any workarounds that maybe require to handle situation not directly covered 

in the application e.g. How to i model a Heat pump in energy targeting?. NOTE: For 

University of Manchester students' your supervisor should be the primary point of contact for 

technology based question. The software support team have explicit instruction not to tell 

student "How to solve their coursework". They will give guidance on how to use the software.  

 Software related issues - These usually relate to unexpected program behaviour (i.e. crash) or 

concerns over a given result, licence file issues etc. NOTE: Previous versions of application 

are not supported. Please ensure that you have the latest version installed. See Help\About for 

version and build date information  

There is a significant amount of information in both categories in :-  

 The on-line help - The on-line help (F1) for most application is the primary source of the 

description of the application, effect of selecting various option, workarounds etc. The on-line 

help has a powerful search facility to assist in finding help pages that may be of benefit. The 

on-line help also has an FAQ's section covering some common issue that user experience.  

 The support Web pages - The pages (accessible from the main help menu) contain details of 

the latest version of the application, down-loadable installation images and details of any 

enhancement or major bug fixes. 

https://www.ceas.manchester.ac.uk/cpi/research/resources/software/ 

 Installation Guide - This can be useful in identifying where the component of a application 

are stored and how to configure the system for non-standard installations.  

When contacting the support team always: -  

 Send a copy of the data file if applicable (data confidentially would apply to any external 

based user request)  

 What application, version number, builds date (see Help\About). Version of windows 

(XP,8,10 32or 64bit)  

 For unexpected program behaviour the exact sequence of events that can be used to 

demonstrate the behaviour  

 What steps already taken to resolve the issue and their outcome  

 Contact details if not a registered student. NOTE: Email addresses (i.e. private email etc.) 

from unknown organisation will not be responded to.  

Contact information 

The Software Team 

Centre Process Integration 

mk:@MSITStore:C:/APPS_CPI/HELP/str_help.chm::/GEN_FAQ.HTM
https://www.ceas.manchester.ac.uk/cpi/research/resources/software/
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Department of  Chemical Engineering 

5
th

  Floor, Core 4E, Nancy Rothwell Building 

The University of Manchester 

Oxford Road 

Manchester 

M13 9PL 

UK 

 

Tel : +44(0)161 529 3801 

Mail : CPITtechSup@manchester.ac.uk 

Web : www.manchester.ac.uk/cpi 

 

 

 

 

 

 

Windows is a regstered trademark of Microsoft corporation, http://www.microsoft.com 

 

GAMS is available from GAMS Development corporation, http://www.gams.com 

 

Aspen Plus and Hysys are © Aspen Technology Inc. http://www.aspentech.com 

 

UniSim © Honeywell Process Solutions Inc. http://www.honeywellprocess.com 
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